Journal of Visualized Experiments

Multicolor 3D printing of complex intracranial tumors in neurosurgery

Article Type:
Manuscript Number:
Full Title:
Section/Category:
Keywords:

Corresponding Author:

Corresponding Author's Institution:

Corresponding Author E-Mail:
Order of Authors:

Additional Information:

Question

--Manuscript Draft--

Invited Methods Article - Author Produced Video

JoVEB0471R1

Multicolor 3D printing of complex intracranial tumors in neurosurgery
JoVE Medicine

3D printing, multicolor, full color, fully colored, neurosurgery, chondrosarcoma, skull
base, anatomical model, skull model, surgical simulation, preoperative planning, binder
jetting, tumor

Michael Kosterhon
University Medical Center of the Johannes Gutenberg-University Mainz
Mainz, GERMANY

University Medical Center of the Johannes Gutenberg-University Mainz
mikoster@uni-mainz.de

Michael Kosterhon

Meik Neufurth

Axel Neulen

Lea Schéafer

Jens Conrad

Sven R. Kantelhardt

Werner E. G. Muller

Florian Ringel

Response

Please indicate whether this article will be Open Access (US$3000)

Standard Access or Open Access.

Powered by Editorial Manager® and ProduXion Manager® from Aries Systems Corporation



Cover Letter

To
Ronald Myers, Ph.D.
Senior Science Editor JoVE

Dear Dr. Myers

enclosed please find our revised manuscript entitled “Multicolor 3D printing of complex

intracranial tumors in neurosurgery*

We thank you very much for your invitation to publish our work in JOVE. We are very glad

that you give us the opportunity to submit the revised version of our manuscript and video to

your journal.

The revised video file will be uploaded to the dropbox account provided by Mr. Steindel.

Enclosed also find the rebuttal letter indicating all changes made to the manuscript and video.

Thank you very much for your efforts.

Sincerely yours,

Michael Kosterhon, M.D.

Department of Neurosurgery

University Medical Center of the Johannes Gutenberg-University Mainz, Germany

Langenbeckstrasse 1, 55131 Mainz
Phone: 0049-6131-177331, Fax: 0049-6131-172774

mikoster@uni-mainz.de



Manuscript

O oo NOOULLA~ WN B

P PP, PP, PA,DPDPDWWWWWWWWWWNDNNNNNMNNNMNNRRPRPRRRRRRPR
AP OWOWNPFPOOONOOTUD_WNPOOONOOULLPAEWNPEPRPOOONOULPE WNEO

Click here to
access/download;Manuscript;60471_R1_101019.docx

TITLE:
Multicolor 3D Printing of Complex Intracranial Tumors in Neurosurgery

AUTHORS AND AFFILIATIONS:
Michael Kosterhon!, Meik Neufurth?, Axel Neulen!, Lea Schéafer!, Jens Conrad!, Sven R.

Kantelhardt!, Werner E. G. Miiller?, Florian Ringel?

!Department of Neurosurgery, University Medical Center, Langenbeckstrasse, Mainz, Germany
2Institute of Physiological Chemistry, University Medical Center, Duesbergweg, Mainz, Germany

Corresponding Author:
Michael Kosterhon, M.D. (michael.kosterhon@unimedizin-mainz.de)

Email Addresses of Co-authors:

Meik Neufurth (mneufurt@uni-mainz.de)

Axel Neulen (axel.neulen@unimedizin-mainz.de)

Lea Schafer (sclea@students.uni-mainz.de)

Jens Conrad (jens.conrad@unimedizin-mainz.de)
Sven R. Kantelhardt (sven.kantelhardt@unimedizin-mainz.de)
Werner E.G. Miller (wmueller@uni-mainz.de)

Florian Ringel (florian.ringel@unimedizin-mainz.de)
KEYWORDS:

3D printing, multicolor, full color, fully colored, neurosurgery, chondrosarcoma, skull base,
anatomical model, skull model, surgical simulation, preoperative planning, binder jetting, tumor

SUMMARY:

The protocol describes the fabrication of fully colored three-dimensional prints of patient-
specific, anatomical skull models to be used for surgical simulation. The crucial steps of combining
different imaging modalities, image segmentation, three-dimensional model extraction, and
production of the prints are explained.

ABSTRACT:

Three-dimensional (3D) printing technologies offer the possibility of visualizing patient-specific
pathologies in a physical model of correct dimensions. The model can be used for planning and
simulating critical steps of a surgical approach. Therefore, it is important that anatomical
structures such as blood vessels inside a tumor can be printed to be colored not only on their
surface, but throughout their whole volume. During simulation this allows for the removal of
certain parts (e.g., with a high-speed drill) and revealing internally located structures of a
different color. Thus, diagnostic information from various imaging modalities (e.g., CT, MRI) can
be combined in a single compact and tangible object.

However, preparation and printing of such a fully colored anatomical model remains a difficult
task. Therefore, a step-by-step guide is provided, demonstrating the fusion of different cross-
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sectional imaging data sets, segmentation of anatomical structures, and creation of a virtual
model. In a second step the virtual model is printed with volumetrically colored anatomical
structures using a plaster-based color 3D binder jetting technique. This method allows highly
accurate reproduction of patient-specific anatomy as shown in a series of 3D-printed petrous
apex chondrosarcomas. Furthermore, the models created can be cut and drilled, revealing
internal structures that allow for simulation of surgical procedures.

INTRODUCTION:

Surgical treatment of skull base tumors is a challenging task requiring precise preoperative
planning!. Multimodal imaging using computed tomography (CT) and magnetic resonance
imaging (MRI) provides the surgeon with information about the patient’s individual anatomy. In
clinical practice, this diagnostic information is visualized by displaying a series of two-dimensional
(2D) cross-sections representing different aspects of the anatomy (e.g., CT for visualization of
bone, CT angiography for vessels, MRI for soft tissue).

However, especially for beginners, medical students, and patients, understanding the complex
relations of the different 3D structures to the cross-sectional images is challenging. Beside
cadaveric studies?, this problem could be addressed by establishing real-size anatomical models
of individual pathologies, displaying anatomical structures in different colors3.

Thanks to technical advances in the last years, 3D printing technologies allow cost-effective
construction of complex shapes*°. Therefore, this technique offers the possibility to construct
patient-specific anatomical models that are tangible, clearly depict spatial relations, and can be
used for surgical planning and simulation. Especially in rare and complex cases such as petrous
apex chondrosarcomas, preoperative simulation of tumor removal in an individual case might
help to improve the self-confidence of the surgeon and the patient outcome.

Common FDM-printing (filament deposition modelling) techniques only allow for creating
objects with a closed surface in one or a limited variety of colors®. To provide a model for surgical
simulation that contains various complex shaped anatomical structures mainly nested inside
each other, fully volumetrically colored 3D prints are needed. This allows for a successive removal
of tissue layers until an internal structure is revealed.

Plaster-based color 3D binder jetting is a technique able to produce the required multicolor
models’. Whereas in its standard configurations only the surface of an object can be colored,
herein a modified technique is described to ensure volumetric application of color to internal
anatomical structures.

To demonstrate this technique, cases of patients with skull base chondrosarcomas were selected
as an example. Chondrosarcomas account for 20% of all neoplasia in the skeletal system, mostly
located in the long bones. Primary skull base chondrosarcomas are a rare condition responsible
for 0.1-0.2% of all intracranial tumors®. Mainly located at the petrous apex, these tumors grow
in a complex anatomical environment involving pivotal structures such as the internal carotid
artery, the optic and other cranial nerves, as well as the pituitary gland. Treatment of these
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neoplasms is mainly focused on a total surgical resection, because adjuvant therapies alone (e.g.,
radiation) are not effective enough?.

Due to the complexity and rarity of this tumor entity, preoperative surgical simulation in a 3D
printed skull model might help to better visualize and understand the anatomy and to assist the
surgeon achieve complete resection. As shown by others'®!! 3D printing of patient-specific
models improves both residents’ and experienced neurosurgeons’ understanding of complex
neuroanatomy.

However, creating such individualized models from medical imaging data requires skills in image
segmentation, 3D modelling, and 3D printing, especially when anatomical structures are to be
printed in different colors. This manuscript intends to make fabrication of the described
anatomical models more accessible for others by providing a detailed protocol for converting
medical imaging data into virtual 3D models and for the fabrication of multicolored 3D objects.

The workflow mainly consists of four parts: 1) segmentation of medical imaging data and creation
of a virtual 3D model; 2) preparation of the virtual 3D model for multicolor 3D printing; 3)
preparation for volumetric coloring of selected parts; and 4) 3D printing and post processing.

PROTOCOL:

The protocol was approved by the responsible local ethics committee (Ethikkommission der
Landesarztekammer Rheinland-Pfalz, Deutschhausplatz 3, 55116 Mainz, Germany). All
institutional guidelines for the care and use of patient data were followed.

1. Segmentation of medical imaging data and creation of a virtual 3D model

NOTE: The software we used for segmentation was Amira 5.4.5. The segmentation process can
also be accomplished by using open source software (e.g., 3D Slicer, https://www.slicer.org/)

1.1. Use imaging data with high spatial resolution (e.g., a slice thickness of 1 mm or less). Here, a
cranial CT dataset with a slice thickness of 0.5 mm and additional MRI data with a slice thickness
of 1 mm were used. Use CT data for the segmentation of bone, contrast enhanced T1 MRl images
for the segmentation of tumor and neural structures, as well as time-of-flight (TOF) images for
vessels.

1.2. Download the DICOM files on the computer and open the segmentation software. Import
the files of the different imaging modalities and select the folder with the imaging data.

1.3. Click on the CT images and connect them with a volume rendering module (Volren). Choose
Specular for a more realistic rendering and adjust the color transfer slider to visualize bone only.
Continue by importing the MRI sequences and connect them to a volume rendering module as
well.
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1.4. Registration

1.4.1. Because the MRI and CT images do not overlap, it is necessary to fuse the different imaging
data. Therefore, right click on the MRI dataset and choose Compute > Affine Registration.
Choose Reference by clicking on the white square of the module, then drag the cursor onto the
CT.

1.4.2. In the Registration Module’s properties leave all settings on default and click on Align
Centers, followed by clicking Register. The two different imaging datasets are now fused. Repeat
this step for all further imaging datasets.

1.5. Verification of matching accuracy:

1.5.1. Check the matching accuracy by hiding the volume renderings (click on the orange square
of the module) and adding an OrthoSlice module to the MR images. Click on the white triangle
and choose Colorwash. Next click on the white square, choose Data and connect this port with
the CT data by dragging the mouse onto it.

1.5.2. Adjust the color slider to visualize the neural structures superimposed to the bony skull
structures. Check for any misalignments by toggling the weight factor slider while looking at the
border between the skull and brain surfaces as well as the ventricles. Repeat this procedure on
different slices in coronal and sagittal directions.

1.6. Volumetric editing

1.6.1. Deactivate the OrthoSlice module’s visibility and reactivate volume rendering of the CT.
Go to the CT data and look for the lowest value in the dataset, in this case -2,048.

1.6.2. Next add a Volume Edit module, connect the Volren module with the output data, and set
the Padding Value to -2,048.

1.6.3. Click on Cut Inside and mark the region to be removed in the 3D viewport.
NOTE: It is important to avoid overlapping with parts not intended to be removed.

1.6.4. In this example, parts of the mandible bone and the upper cervical vertebrae were
removed.

1.7. Segmentation of bone
1.7.1. Next, the remaining bone must be segmented and converted into a surface mesh. To do

so, click on the Segmentation Editor, choose the modified CT image sequence, and add a new
Labelset by clicking on New.
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1.7.2. Now choose Threshold as a segmentation option. Set the lower slider to a value of ~250in
case of a CT. Ensure that thin bone structures such as the temporal bone or the upper orbital
region are selected in the preview. Otherwise, adjust the lower threshold but avoid selecting any
soft tissue.

1.7.3. Next click on Select and finally add the selection to the labelset (by clicking on the red plus
icon).

1.7.4. Return to the Pool View. A new labelset has been created for the CT. Right click and choose
Compute > Surface Gen, check the Compactify option, and click Apply.

1.7.5. Finally, add a SurfaceView module and adjust the color of the generated mesh.
1.8. Segmentation of other structures

1.8.1. Add other relevant structures by repeating the previous steps. In case of the tumor, manual
segmentation was used rather than a thresholding operation.

1.8.2. To perform manual segmentation, go to the Segmentation Editor, and choose the manual
segmentation option (brush icon) to mark structures such as the tumor in every slice. Finally add
the selection again by clicking onto the plus icon. Thus, the tumor, the optic nerve, and the
intracranial vessels will be segmented and added to the model.

1.9. Exporting meshes

1.9.1. Finally export the generated meshes in the STL format by right clicking on the mesh and
clicking on Save. Choose binary STL as the file format.

2. Preparation of the virtual 3D model for multicolor printing

NOTE: The software used for print preparation in this protocol is Netfabb Premium 2019.0.
Autodesk offers free use of this software in its educational program.

2.1. Import data and perform automatic repair.

2.2. Open the print preparation program and import the meshes generated in the previous steps
as new parts. Check Automatic Repair and click Import.

2.3. Deleting small loose parts

2.3.1. Select the skull and split its shells into parts by clicking on Modify > Split Shells into Parts.
This separates any loose objects not connected to the skull bone.

2.3.2. Select the skull bone and toggle its visibility off.
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2.3.3. Now select all other parts and delete them.

2.3.4. Toggle the skull’s visibility on again.

2.3.5. Repeat this step for all other objects.

2.4. Remove overlapping regions.

NOTE: In some regions, such as the tumor inside the petrous apex of the skull, the geometries of
both objects intersect each other. To avoid printing errors, it is necessary to remove such
intersections.

2.4.1. Select the two intersecting objects and click on Boolean Operations.

2.4.2. Move the object to be subtracted from the other one to the red side of the list and click on
Apply. Now the two objects are clearly separated. This should be checked by toggling their
visibility.

2.4.3. Repeat these steps to allow the tumor as well as the artery inside the tumor to become
clearly separated from each other.

2.5. Add supporting structures where needed.

2.5.1. In case of the basilar artery, additional supports are needed to prevent the object from
being a loose part after printing.

2.5.2. Add a new object, in this case a cylinder (File > Part Library), and adjust its dimensions and
subdivisions as needed.

2.5.3. Place the cylinder to completely intersect with the skull and the vessel geometry.

2.5.4. Now perform the Boolean operation again to subtract the parts within the bone and the
blood vessel.

2.5.5. Repeat this step to add more supports where needed (e.g., the optic nerve).
3. Preparation for volumetric coloring of selected parts

NOTE: To allow volumetric coloring of certain parts it is necessary to generate not only one
surface shell but many subshells (additional surfaces) inside the object.

3.1. Select the tumor, in this case, and generate a new shell from it (right click > Modify >
Generate Shell).
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3.2. Set a shell thickness of 0.3 mm in the Inner Offset Mode with an accuracy of 0.15 mm and
Apply. Select the Keep Original Part checkbox. This generates an inner shell with a distance of
0.3 mm to the original surface.

3.3. Select the outside surface of both shells and generate a new shell from it. Select a shell
thickness of 0.25 mm in Hollow Mode with an accuracy of 0.15 mm. Also select the Remove
Original Part checkbox. This generates a space of 0.05 mm between the two adjacent shells.

3.4. Repeat steps 3.1-3.3 so that multiple inner shells with constant thicknesses and invariant
offsets are created.

NOTE: It is recommended to use a shell thickness of 0.35—-0.25 mm as well as an offset of 0.1—
0.05 mm to achieve smooth volumetric coloring.

3.5. Repeat steps 3.1-3.4 with all other objects, such as the blood vessels.
4. Coloring and exporting of the 3D model

NOTE: The coloring of all parts of the model, including the distinct nested shells, is done using
the Netfabb software.

4.1. Select a part to be colored in the Parts Menu on the left side. Double click the Texture and
Color Mesh icon. Choose a color by clicking the color bar on the right side. In the top menu left
click on the Paint on Shells icon. Subsequently left click on the model displayed in the screen
center. Finally left click on the Apply Changes box in the lower right corner. Be sure to confirm
the Remove Old Part selection.

4.2. Repeat these steps with all other objects and shells, respectively.

4.3. Export all objects. Select all objects to be printed, including supports and inner shells, and
export them as individual files. Be sure to choose the VRML (WRL) format, because the STL format
is not able to transport the color information.

5. Printing and post processing of the 3D model

5.1. Set up the 3D printer

NOTE: The 3DPrint Software (Version 1.03) was used to control the ZPrinter 450 binder jetting
machine.

5.1.1. Open the software and import the colored VRML files by clicking on Open and choosing all
relevant data. Click on the Open button in the lower right window corner. In the subsequent
window choose millimeters as units. Make sure to check the Keep Position and Orientation as
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well as the Apply Settings to All Files boxes. Finally choose Z151 as the material type. Click on
the Next button.

5.1.2. For positioning the 3D objects inside of the build volume, mark all objects by pressing the
<STRG>+A key.

5.1.2.1. In the upper left window, representing the XY view of the build volume, click and drag
the marked objects to the center. In the lower left window, representing the XZ view of the build
volume, click and drag the objects in the middle of the lower part above the yellow line.

5.1.2.2. If a whole skull model is printed, be sure that the opening is facing upwards. If isolated
small models are printed, be sure to align delicate parts such as vessels with the XY plane,
because this orientation will increase the strength of the respective parts.

5.1.2.3. Check the correct orientation of the models by clicking and moving them in the window
on the right-hand side.

5.1.3. To prepare for the build process, click on the Setup icon in the upper menu. Make sure
that the correct Material Type is selected and that the Layer Thickness is set to 0.1 mm. The
Bleed Compensation should be checked and the Print in Monochrome option unchecked.

5.1.4. To start the printing process, click on the Build icon in the upper menu. In the subsequent
window choose Entire Build and click the OK button. Be sure that in the following Printer Status
dialogue all listed items are set correctly and that the printer is online. Then, click on the Print
button in the lower part of the dialogue box.

5.2. Post processing of the model

NOTE: Always wear a laboratory coat, gloves, eye protection, and a mask while handling the loose
powder and the hardening solution. Always work in a well-ventilated area.

5.2.1. Unpacking

5.2.1.1. After the print is finished, unpack the model by carefully removing the loose powder with
the integrated vacuum cleaner. It is important not to directly contact the model with the suction
tube to prevent thin structures from breaking apart.

5.2.1.2. Remove the model and clean it by applying pressurized air as well as cleaning it with a
soft brush. Thicker, more stable, parts of the model can additionally be ground with a harder
brush. This optional step allows for a smoother surface finish. Keep in mind that in this state the
model is still very fragile.

5.2.2. Infiltration
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5.2.2.1. Put the model inside a plastic tub.
5.2.2.2. Infiltrate it carefully with the hardening solution until no whitish areas are visible.

5.2.2.3. The surplus solution has to be removed with pressurized air and disposable paper towels
to maintain all the surface details.

5.2.2.4. Let the model cure for several hours until it is completely dry.

REPRESENTATIVE RESULTS:

Eight patients with chondrosarcoma of the petrous apex were selected for the study and virtual
3D models were created, each containing bone, tumor, vessels, pituitary gland, and optic nerve
crossing. Three models underwent multicolored 3D printing using the plaster-based color 3D
binder jetting technique (Figure 1A1,A2). Additionally, a single tumor with an internal artery was
created (Figure 1B1) to show the benefits of volumetric coloring compared to surface coloring
(Figure 1B2,B3).

These models were used to demonstrate the simulation of a surgical approach (e.g., burr hole
creation) and tumor resection. This printing technique allowed for combining anatomical
structures derived from different imaging modalities into one single object.

The plaster material had bone-like properties and could be easily drilled without melting. Thus,
it was feasible to use it to simulate a surgical access route. After the hardening procedure it was
stable enough to reproduce even fragile structures such as the intracerebral vessel tree.

The ability to color the entire volume of the model allowed an object’s internal structure, such
as the internal carotid artery travelling through the tumor, to be clearly visualized. By removing
layers of tumor with the drill, the red artery was gradually revealed during the surgical simulation.

To prove the accuracy of the technique, 3D models were scanned in a computer tomograph. The
models created for printing were superimposed to these scans. A deviation mapping was created,
and the accuracy was determined in 50 randomly chosen surface points. A mean deviation of
0.021 mm demonstrates the high accordance of the 3D print compared to the original data.

FIGURE AND TABLE LEGENDS:

Figure 1: Volumetric vs. surface colored 3D prints. A1. Exemplary full color 3D print of a patient
with chondrosarcoma at the right petrous apex. A2. Detailed view of anatomical structures
(arrow = internal carotid artery bifurcation; O = optic nerve chiasm; T = tumor). B1. Blood vessel
crossing the tumor volume and cross-sectional level (dotted line). B2. The conventional
multicolor printing technique reveals color only at the surface. B3. The modified technique
produces volumetrically colored objects suitable for advanced surgical simulation.

Figure 2: Workflow for volumetric coloring of 3D prints. A. Virtual 3D model of a tumor with a
blood vessel crossing its volume without inner shells. B. A tumor and a blood vessel with multiple
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inner shells (distance 0.05 mm). C. An example of a high shell distance (1 mm). The single layers
of colored and white shells are still visible. D. An example of small shell distance (0.1 mm). The
object’s inner volume is completely colored.

DISCUSSION:

The therapy of intracranial chondrosarcoma is mainly based on complete surgical removal. Often
located on the petrous apex, this tumor is close to important structures such as the internal
carotid artery, the optic nerve, and the pituitary gland. Therefore, planning the surgical
trajectories is a crucial step prior to surgery. Multicolor 3D printing allows for fusion of these
structures, each derived from different imaging modalities, into a single object.

During the preparation for 3D printing it is important to carefully select adequate imaging data.
High resolution images with a small slice thickness are well suited for 3D reconstruction and
smooth transitions, whereas high slice thicknesses will produce coarse, uneven objects. Another
critical step of the method is to avoid any intersections of two neighboring objects such as tumor
and skull bone. Therefore, Boolean operations have to be performed to subtract one object from
the other.

To allow for volumetric coloring it is necessary to create onion shell-like subsurfaces inside an
object (Figure 2A,B). It is necessary to have a minimum distance between two adjacent surfaces
of at least 0.1 mm to obtain smoothly colored objects (Figure 2D). If the distance chosen is above
this value, the individual shells inside the object might become visible (Figure 2C). Attention
should be paid to an increased color consumption of the 3D printer when using volumetric
coloring. Furthermore, it is also important to check the model for any loose parts and add
supports when necessary (e.g., the basilar artery).

The method can only produce stiff, plaster-like material that is not very durable. Especially
without the hardening procedure, the model can be easily destroyed during the unpacking
procedure. Thus, fragile elements such as blood vessels often tend to break apart.

The technique is also not suitable for simulation of soft tissue. To simulate brain tissue, for
example, it might be necessary to either print it with a method that is able to produce soft and
hard materials directly'>!3 or to print molds that can be used to cast soft objects, such as silicone
rubber!®. In one test case, the latter method was used to simulate a soft tumor. The limitation of
this last procedure was that although the silicone tumor was very flexible, it was necessary to
have enough space to insert it into the 3D printed model. Furthermore, it was not possible to
create inner structures, such as a blood vessel.

3D binder jetting is an additive manufacturing technique that assembles objects by partial
hardening and coloring thin layers of plaster powder. Thus, it allows for printing a nearly
unlimited range of colors, color transitions, and colored structures inside the volume of objects
in one single process.

Compared to other printing techniques such as filament printers, which produce the lowest costs
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but only allow two or three colors at once, and Poly Jet printers that produce multicolor, multi-
material objects but are very expensive, this technique offers a compromise at an affordable
price. The mean material cost for a printed skull was about 150 €.

With this method it is possible to visualize even more abstract data such as filament fibers derived
from MRI fiber tracking sequences or functional imaging depicting, for example, the brain speech
area (e.g., Broca’s area).

Apart from surgical simulation, 3D printed, fully colored models of real patient anatomy can help
improve the education of medical students or young physicians so they can better understand
complex anatomical relations. It is also an important tool in patient education.
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3D printer

3D Systems (formerly Zcorp)

3D printing software

3D Systems (formerly Zcorp)

Binder solution for cartridge

4D Concepts GmbH, GroR-Gerau, Germany

42-0100-7001

Infiltration solution

4D Concepts GmbH, GroR-Gerau, Germany

42-0250-1090

Modeling Software for 3D print
preparation

Autodesk, San Rafael, CA, USA

X

Print head for binder

4D Concepts GmbH, GroR-Gerau, Germany

42-0150-2010

Print head for color

4D Concepts GmbH, GroR-Gerau, Germany

42-0150-2011

Printing powder

4D Concepts GmbH, GroR-Gerau, Germany

42-0050-2061

Segmentation software

Thermo Fisher Scientific, Waltham, MA, USA

X



https://www.editorialmanager.com/jove/download.aspx?id=1123297&guid=f490a579-c7d7-4952-a794-3663361dba87&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1123297&guid=f490a579-c7d7-4952-a794-3663361dba87&scheme=1

Comments/Description

Zprinter Z450

3DPrint Software (Version 1.03)

VisiJet PXL Binder Cartridge clear 1 x ca. 1 Liter

Color-Bond 90, 1 bottle, 454 g

Netfabb Premium (Version 2019.0)

HP 11 print head (C4810A)

HP 57 printhead C 6657 AE Tricolor

VisiJet PXL Core Eco Drum ca. 14 kg - ca. 11,47 L

Amira 5.4.5
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ARTICLE AND VIDEO LICENSE AGREEMENT

Title of Article:

Multicolor 3D printing of complex intracranial tumors in neurosurgery
for research, training and individualized treatment planning

Author(s):

Michael Kosterhon, Meik Neufurth, Axel Neulen, Lea Schéfer,
Jens Conrad, Sven R. Kantelhardt, Werner E. G. Miiller, Florian Ringel

Iltem 1: The Author elects to have the Materials be made available (as described at

http://www.jove.com/publish) via:
D Standard Access

Item 2: Please select one of the following items:

IZI Open Access

The Author is NOT a United States government employee.

I:’The Author is a United States government employee and the Materials were prepared in the
course of his or her duties as a United States government employee.

DThe Author is a United States government employee but the Materials were NOT prepared in the
course of his or her duties as a United States government employee.

ARTICLE AND VIDEO LICENSE AGREEMENT

1. Defined Terms. As used in this Article and Video
License Agreement, the following terms shall have the
following meanings: “Agreement” means this Article and
Video License Agreement; “Article” means the article
specified on the last page of this Agreement, including any
associated materials such as texts, figures, tables, artwork,
abstracts, or summaries contained therein; “Author”
means the author who is a signatory to this Agreement;
“Collective Work” means a work, such as a periodical issue,
anthology or encyclopedia, in which the Materials in their
entirety in unmodified form, along with a number of other
contributions, constituting separate and independent
works in themselves, are assembled into a collective whole;
“CRC License” means the Creative Commons Attribution-
Non Commercial-No Derivs 3.0 Unported Agreement, the
terms and conditions of which can be found at:
http://creativecommons.org/licenses/by-nc-

nd/3.0/legalcode; “Derivative Work” means a work based
upon the Materials or upon the Materials and other pre-
existing works, such as a translation, musical arrangement,
dramatization, fictionalization, motion picture version,
sound recording, art reproduction, abridgment,
condensation, or any other form in which the Materials may
be recast, transformed, or adapted; “Institution” means
the institution, listed on the last page of this Agreement, by
which the Author was employed at the time of the creation
of the Materials; “JoVE” means Mylove Corporation, a
Massachusetts corporation and the publisher of The Journal
of Visualized Experiments; “Materials” means the Article
and / or the Video; “Parties” means the Author and JoVE;
“Video” means any video(s) made by the Author, alone or
in conjunction with any other parties, or by JoVE or its
affiliates or agents, individually or in collaboration with the
Author or any other parties, incorporating all or any portion

of the Article, and in which the Author may or may not
appear.

2. Background. The Author, who is the author of the
Article, in order to ensure the dissemination and protection
of the Article, desires to have the JoVE publish the Article
and create and transmit videos based on the Article. In
furtherance of such goals, the Parties desire to memorialize
in this Agreement the respective rights of each Party in and
to the Article and the Video.

= Grant of Rights in Article. In consideration of JoVE
agreeing to publish the Article, the Author hereby grants to
JOVE, subject to Sections 4 and 7 below, the exclusive,
royalty-free, perpetual (for the full term of copyright in the
Article, including any extensions thereto) license (a) to
publish, reproduce, distribute, display and store the Article
in all forms, formats and media whether now known or
hereafter developed (including without limitation in print,
digital and electronic form) throughout the world, (b) to
translate the Article into other languages, create
adaptations, summaries or extracts of the Article or other
Derivative Works (including, without limitation, the Video)
or Collective Works based on all or any portion of the Article
and exercise all of the rights set forth in (a) above in such
translations, adaptations, summaries, extracts, Derivative
Works or Collective Works and(c) to license others to do any
or all of the above. The foregoing rights may be exercised in
all media and formats, whether now known or hereafter
devised, and include the right to make such modifications
as are technically necessary to exercise the rights in other
media and formats. If the “Open Access” box has been
checked in Item 1 above, JoVE and the Author hereby grant
to the public all such rights in the Article as provided in, but
subject to all limitations and requirements set forth in, the
CRC License.
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4, Retention of Rights in Article. Notwithstanding
the exclusive license granted to JoVE in Section 3 above, the
Author shall, with respect to the Article, retain the non-
exclusive right to use all or part of the Article for the non-
commercial purpose of giving lectures, presentations or
teaching classes, and to post a copy of the Article on the
Institution’s website or the Author’s personal website, in
each case provided that a link to the Article on the JoVE
website is provided and notice of JoVE’s copyright in the
Article is included. All non-copyright intellectual property
rights in and to the Article, such as patent rights, shall
remain with the Author.

5. Grant of Rights in Video — Standard Access. This
Section 5 applies if the “Standard Access” box has been
checked in Item 1 above or if no box has been checked in
Item 1 above. In consideration of JoVE agreeing to produce,
display or otherwise assist with the Video, the Author
hereby acknowledges and agrees that, Subject to Section 7
below, JoVE is and shall be the sole and exclusive owner of
all rights of any nature, including, without limitation, all
copyrights, in and to the Video. To the extent that, by law,
the Author is deemed, now or at any time in the future, to
have any rights of any nature in or to the Video, the Author
hereby disclaims all such rights and transfers all such rights
to JoVE.

6. Grant of Rights in Video — Open Access. This
Section 6 applies only if the “Open Access” box has been
checked in Item 1 above. In consideration of JoVE agreeing
to produce, display or otherwise assist with the Video, the
Author hereby grants to JoVE, subject to Section 7 below,
the exclusive, royalty-free, perpetual (for the full term of
copyright in the Article, including any extensions thereto)
license (a) to publish, reproduce, distribute, display and
store the Video in all forms, formats and media whether
now known or hereafter developed (including without
limitation in print, digital and electronic form) throughout
the world, (b) to translate the Video into other languages,
create adaptations, summaries or extracts of the Video or
other Derivative Works or Collective Works based on all or
any portion of the Video and exercise all of the rights set
forth in (a) above in such translations, adaptations,
summaries, extracts, Derivative Works or Collective Works
and (c) to license others to do any or all of the above. The
foregoing rights may be exercised in all media and formats,
whether now known or hereafter devised, and include the
right to make such modifications as are technically
necessary to exercise the rights in other media and formats.
For any Video to which this Section 6 is applicable, JoVE and
the Author hereby grant to the public all such rights in the
Video as provided in, but subject to all limitations and
requirements set forth in, the CRC License.

7. Government Employees. If the Author is a United
States government employee and the Article was prepared
in the course of his or her duties as a United States
government employee, as indicated in Item 2 above, and
any of the licenses or grants granted by the Author
hereunder exceed the scope of the 17 U.S.C. 403, then the
rights granted hereunder shall be limited to the maximum
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rights permitted under such statute. In such case, all
provisions contained herein that are not in conflict with
such statute shall remain in full force and effect, and all
provisions contained herein that do so conflict shall be
deemed to be amended so as to provide to JoVE the
maximum rights permissible within such statute.

8. Protection of the Work. The Author(s) authorize
JoVE to take steps in the Author(s) name and on their behalf
if JOVE believes some third party could be infringing or
might infringe the copyright of either the Author’s Article
and/or Video.

9. Likeness, Privacy, Personality. The Author hereby
grants JoVE the right to use the Author’s name, voice,
likeness, picture, photograph, image, biography and
performance in any way, commercial or otherwise, in
connection with the Materials and the sale, promotion and
distribution thereof. The Author hereby waives any and all
rights he or she may have, relating to his or her appearance
in the Video or otherwise relating to the Materials, under
all applicable privacy, likeness, personality or similar laws.
10. Author Warranties. The Author represents and
warrants that the Article is original, that it has not been
published, that the copyright interest is owned by the
Author (or, if more than one author is listed at the beginning
of this Agreement, by such authors collectively) and has not
been assigned, licensed, or otherwise transferred to any
other party. The Author represents and warrants that the
author(s) listed at the top of this Agreement are the only
authors of the Materials. If more than one author is listed
at the top of this Agreement and if any such author has not
entered into a separate Article and Video License
Agreement with JoVE relating to the Materials, the Author
represents and warrants that the Author has been
authorized by each of the other such authors to execute this
Agreement on his or her behalf and to bind him or her with
respect to the terms of this Agreement as if each of them
had been a party hereto as an Author. The Author warrants
that the use, reproduction, distribution, public or private
performance or display, and/or modification of all or any
portion of the Materials does not and will not violate,
infringe and/or misappropriate the patent, trademark,
intellectual property or other rights of any third party. The
Author represents and warrants that it has and will
continue to comply with all government, institutional and
other regulations, including, without limitation all
institutional, laboratory, hospital, ethical, human and
animal treatment, privacy, and all other rules, regulations,
laws, procedures or guidelines, applicable to the Materials,
and that all research involving human and animal subjects
has been approved by the Author's relevant institutional
review board.

11. JoVE Discretion. If the Author requests the
assistance of JoVE in producing the Video in the Author’s
facility, the Author shall ensure that the presence of JoVE
employees, agents or independent contractors is in
accordance with the relevant regulations of the Author's
institution. If more than one author is listed at the
beginning of this Agreement, JoVE may, in its sole
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discretion, elect not take any action with respect to the
Article until such time as it has received complete, executed
Article and Video License Agreements from each such
author. JoVE reserves the right, in its absolute and sole
discretion and without giving any reason therefore, to
accept or decline any work submitted to JoVE. JoVE and its
employees, agents and independent contractors shall have
full, unfettered access to the facilities of the Author or of
the Author’s institution as necessary to make the Video,
whether actually published or not. JoVE has sole discretion
as to the method of making and publishing the Materials,
including, without limitation, to all decisions regarding
editing, lighting, filming, timing of publication, if any,
length, quality, content and the like.

12. Indemnification. The Author agrees to indemnify
JoVE and/or its successors and assigns from and against any
and all claims, costs, and expenses, including attorney’s
fees, arising out of any breach of any warranty or other
representations contained herein. The Author further
agrees to indemnify and hold harmless JoVE from and
against any and all claims, costs, and expenses, including
attorney’s fees, resulting from the breach by the Author of
any representation or warranty contained herein or from
allegations or instances of violation of intellectual property
rights, damage to the Author’s or the Author’s institution’s
facilities, fraud, libel, defamation, research, equipment,
experiments, property damage, personal injury, violations
of institutional, laboratory, hospital, ethical, human and
animal treatment, privacy or other rules, regulations, laws,
procedures or guidelines, liabilities and other losses or
damages related in any way to the submission of work to
JoVE, making of videos by JoVE, or publication in JoVE or
elsewhere by JoVE. The Author shall be responsible for, and
shall hold JoVE harmless from, damages caused by lack of
sterilization, lack of cleanliness or by contamination due to
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the making of a video by JoVE its employees, agents or
independent contractors. All sterilization, cleanliness or
decontamination procedures shall be solely the
responsibility of the Author and shall be undertaken at the
Author’s expense. All indemnifications provided herein
shall include JoVE’s attorney’s fees and costs related to said
losses or damages. Such indemnification and holding
harmless shall include such losses or damages incurred by,
or in connection with, acts or omissions of JoVE, its
employees, agents or independent contractors.

13. Fees. To cover the cost incurred for publication,
JoVE must receive payment before production and
publication the Materials. Payment is due in 21 days of
invoice. Should the Materials not be published due to an
editorial or production decision, these funds will be
returned to the Author. Withdrawal by the Author of any
submitted Materials after final peer review approval will
result in a USS1,200 fee to cover pre-production expenses
incurred by JoVE. If payment is not received by the
completion of filming, production and publication of the
Materials will be suspended until payment is received.

14. Transfer, Governing Law. This Agreement may be
assigned by JoVE and shall inure to the benefits of any of
JoVE's successors and assignees. This Agreement shall be
governed and construed by the internal laws of the
Commonwealth of Massachusetts without giving effect to
any conflict of law provision thereunder. This Agreement
may be executed in counterparts, each of which shall be
deemed an original, but all of which together shall be
deemed to me one and the same agreement. A signed copy
of this Agreement delivered by facsimile, e-mail or other
means of electronic transmission shall be deemed to have
the same legal effect as delivery of an original signed copy
of this Agreement.

A signed copy of this document must be sent with all new submissions. Only one Agreement is required per submission.

CORRESPONDING AUTHOR
Name: -
Michael Kosterhon
Department:
Department of Neurosurgery
IRSEIEOTion; University Medical Center of the Johannes Gutenberg-University Mainz
Title: Dr. med. (MD)
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Signature: K%@,{_

Date: June 24, 2019
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1. Upload an electronic version on the JoVE submission site
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First revision of JoOVE60471 “Multicolor 3D printing of complex
intracranial tumors in neurosurgery for research, training and
individualized treatment planning”

Changes made according to the editor’s and reviewer’s statements are in italics.

Editorial and production comments:
Changes to be made by the Author(s) regarding the written manuscript:

1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there are
no spelling or grammar issues. The JOVE editor will not copy-edit your manuscript and any
errors in the submitted revision may be present in the published version.

The manuscript has been carefully proofread again and spelling as well as grammar issues
have been corrected to the best of our knowledge.

2. Please submit each figure as a vector image file to ensure high resolution throughout
production: (.psd, ai, .eps., .svg).

The figures are all produced as pixel graphics and contain images. Therefore it is not
possible to provide a vector image file.

3. Figure 1: Please remove “Fig 1”.
4. Figure 2: Please remove “Fig 2”.
“Fig 1” and “Fig 2" have been removed from the figures

5. Title: Please shorten the title for brevity. “for research, training and 3 individualized
treatment planning” can be removed.
The title has been shortened in the manuscript and the video as proposed.

6. Please rephrase the Summary to clearly describe the protocol and its applications in
complete sentences between 10-50 words: “Here, we present a protocol to ...”

The Summary has been shortened and modified as follows:

“The protocol describes the fabrication of fully colored 3D prints of patient-specific,
anatomical skull models to be used for surgical simulation. The crucial steps of combining
different imaging modalities, image segmentation, 3D model extraction and production of the
3D print are explained. “

7. Please ensure that the references appear as the following: [Lastname, F.I., LastName, F.I.,
LastName, F.I. Article Title. Source. Volume (Issue), FirstPage — LastPage (YEAR).] For
more than 6 authors, list only the first author then et al.

The references have been modified according to the JOVE EndNote style provided on the
JOVE website.

8. Please include volume and issue numbers for all references.
The references have been modified according to the JOVE EndNote style provided on the
JoVE website. For some references this data was not available.

9. Please cite at least 10 prior publications.
Additional publications were added to the manuscript.

10. For in-text formatting, corresponding reference numbers should appear as numbered
superscripts after the appropriate statement(s).

I+
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The references and in-text formatting have been modified according to the JoVE EndNote
style provided on the JOVE website.

11. Please revise the text to avoid the use of any personal pronouns (e.g., "we", "you", "our"
etc.).

All personal pronouns were removed.

12. Please include an ethics statement before the numbered protocol steps, indicating that the
protocol follows the guidelines of your institution’s human research ethics committee.
A statement about the ethics committee’s approval was inserted.

13. Please provide a title for each figure.

A title for each figure legend in the protocol was added.
“Figure 1 — Volumetric vs. surface colored 3D prints”
“Figure 2 — Workflow for volumetric coloring of 3D prints”

Changes to be made by the Author(s) regarding the video:

1. Please ensure that the video title matches the article title. We suggested changes above.
The shorter title has been integrated in the video as well.

2. Please repeat the title slide at the end of the video as well.
Title slide was inserted at the end of the video again.

Reviewers' comments:

Reviewer #1:

Manuscript Summary:

The manuscript is well written and protocols are clearly explained. Topic is of high interest
for 3D printing techniques for biomedical purposes.

Major Concerns:

the hard material described is good for a bone drilling simulation. However it is not suitable
for other tissues simulation (vessels, soft tissues). It would be interesting to know if the
authors are planning to work also on this kind of tissues.

The following paragraph has been added in the Limitations section of the paper’s Discussion:
“To simulate e.g. the brain tissue it might be necessary to either print this with a method that
is able to produce soft materials directly or to print molds that can be used to cast soft objects
e.g. from silicone rubber. In one test case the latter method was used to simulate a soft tumor.
The limitation of this procedure was that although the silicone tumor was very flexible it is
always necessary to have enough space to insert it into the 3D printed model. Furthermore it
is not possible to create inner structures such as a blood vessel.”

Minor Concerns:
I would enclose and discuss the following references for discussion:

Quantitative evaluation of different far lateral approaches to the cranio-vertebral junction
using the microscope and the endoscope: a cadaveric study using a tumor model. PMID:
29479657

A workflow to generate physical 3D models of cerebral aneurysms applying open source
freeware for CAD modeling and 3D printing.



Both references have been enclosed in the Introduction part.

Reviewer #2:

Manuscript Summary:

Congratulations on your manuscript, the results in the images are great, the method is
straightforward and easy to understand with some experience in the 3D printing area

Major Concerns:
None

Minor Concerns:

There are some minor grammatical and syntax errors in the manuscripts, mainly repetitive
sentences which should be addressed.

The manuscript has been carefully proofread again and spelling as well as grammar issues
have been corrected to the best of our knowledge.



